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m Introduction

This guide provides reference information for the creation and use of Intelligent Application Gadget
(IAG) objects. It does not provide safety information.

Be sure to obtain the NA-series Programmable Terminal User's Manuals, read and understand the
safety points and other information required for use, and test sufficiently before actually using the
equipment.

Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation in Japan
and other countries for OMRON factory automation products.

Other company names and product names in this document are the trademarks or registered
trademarks of their respective companies.

Microsoft product screen shots are reprinted with permission from Microsoft Corporation.



Terms and Conditions Agreement

Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

® Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and
workmanship for a period of twelve months from the date of sale by Omron (or such other period
expressed in writing by Omron). Omron disclaims all other warranties, express or implied.

® Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED,
ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS
DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF
THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses
based on infringement by the Products or otherwise of any intellectual property right.

® Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or replacement
thereof) the non-complying Product, (ii) repair the non-complying Product, or (iii) repay or
credit Buyer an amount equal to the purchase price of the non-complying Product; provided
that in no event shall Omron be responsible for warranty, repair, indemnity or any other
claims or expenses regarding the Products unless Omron’s analysis confirms that the
Products were properly handled, stored, installed and maintained and not subject to
contamination, abuse, misuse or inappropriate modification. Return of any Products by
Buyer must be approved in writing by Omron before shipment. Omron Companies shall not
be liable for the suitability or unsuitability or the results from the use of Products in
combination with any electrical or electronic components, circuits, system assemblies or any
other materials or substances or environments. Any advice, recommendations or
information given orally or in writing, are not to be construed as an amendment or addition to
the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published
information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR
COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER
SUCH CLAIM IS BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT
LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the
Product on which liability is asserted.




Terms and Conditions Agreement

Application Considerations

I Suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or
regulations which apply to the combination of the Product in the Buyer’s application or use
of the Product. At Buyer’s request, Omron will provide applicable third party certification
documents identifying ratings and limitations of use which apply to the Product. This
information by itself is not sufficient for a complete determination of the suitability of the
Product in combination with the end product, machine, system, or other application or use.
Buyer shall be solely responsible for determining appropriateness of the particular Product
with respect to Buyer’s application, product or system. Buyer shall take application
responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO
LIFE OR PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS
BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL
EQUIPMENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable
Product, or any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a
guide for the user in determining suitability and does not constitute a warranty. It may
represent the result of Omron’s test conditions, and the user must correlate it to actual
application requirements. Actual performance is subject to the Omron’s Warranty and
Limitations of Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons. It is our practice to change part numbers when published
ratings or features are changed, or when significant construction changes are made.
However, some specifications of the Product may be changed without any notice. When in
doubt, special part numbers may be assigned to fix or establish key specifications for your
application. Please consult with your Omron’s representative at any time to confirm actual
specifications of purchased Product.

I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical or proofreading
errors or omissions.
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1.Related Manuals

1 Related Manuals

The following manuals are related to this manual.

Cat. No.

Model

Manual name

V117

NA5-15Woooo
NA5-12Woooo
NA5-OQWoooo
NA5-7Woooo

NA-series Programmable Terminal Hardware User's Manual

V118

NA5-15Woooo
NA5-12Woooo
NA5-OQWoooo
NA5-7Woooo

NA-series Programmable Terminal Software User's Manual

V119

NA5-15Woooo
NA5-12Woooo
NA5-9Woooo
NA5-7Woooo

NA-series Programmable Terminal Device Connection User’s
Manual

V120

NA5-15Woooo
NA5-12Woooo
NA5-9Woooo
NA5-7Woooo

NA-series Programmable Terminal Startup Guide

W504

SYSMAC-SE20ono

Sysmac Studio Version 1 Operation Manual

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)



2.Precautions

2 Precautions

(1)When building an actual system, check the specifications of the component devices of
the system, use within the ratings and specified performance, and implement safety
measures such as safety circuits to minimize the possibility of an accident.

(2) For safe use of the system, obtain the manuals of the component devices of the system
and check the information in each manual, including safety precautions, precautions for
safe use.

(3) 1t is the responsibility of the customer to check all laws, regulations, and standards that
the system must comply with.

(4)All rights reserved. No part of this publication may be reproduced, stored in a retrieval
system, or transmitted, in any form, or by any means, mechanical, electronic,
photocopying, recording, or otherwise, without the prior written permission of OMRON.

(5) The information in this guide is current as of March 2015.

No patent liability is assumed with respect to the use of the information contained herein.
Moreover, because OMRON is constantly striving to improve its high-quality products,
the information contained in this guide is subject to change without notice.

(6) The operation of each design template has tested using the device configuration
indicated in section 3-3 of this guide. The operation of screens after incorporation of the
templates is not guaranteed.

Special information in this document is classified as follows:

@ Precautions for Safe Use

Indicates precautions on what to do and what not to do to ensure safe usage of
the product.

I"_’l Precautions for Correct Use

Indicates precautions on what to do and what not to do to ensure proper operation
and performance.

|j$ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operation easier.

Copyrights and Trademarks

Screenshots are used in accordance with Microsoft Corporation guidelines.
Windows,Visual Basic is a registered trademark of Microsoft Corporation in the USA
and other countries.

EtherCAT® is registered trademark and patented technology, licensed by Beckhoff
Automation GmbH, Germany.

Company names and product names in this document are the trademarks or
registered trademarks of their respective companies.

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)



3.Introduction

3 Introduction

3-1 Introduction

The NA series enables the creation and use of Intelligent Application Gadget (IAG) objects
that incorporate a Visual Basic program.

OMRON provides samples of frequently used objects as an IAG library.

As an example, when the alarm viewer is used as shown below, the IAG objects are
arranged together with the viewer to allow operation of the viewer screen.

Date and Time Message

IAG library for object
Obiject to be controlled control
"Ali\rm Viewer" LES5208 2 2 "IAG for Alarm Viewer
control"

This guide describes the following functions and objects.
* Alarm/Alarm Viewer Objects

* Recipe/Recipe Viewer Objects

» Data Logging/Trend Graph Objects

* Media Player Objects

This guide describes the following of the functions and objects listed above.
« List of the IAG objects that are provided by a library

» External specification for an individual IAG object

» Methods of importing and setting IAG library

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)

10



3.Introduction

3-2 Provided Files

The following files are provided.

Distribution Files (.iag)

* OmronStandardlAG_114A_E_AlarmButtons.iag

* OmronStandardIAG_114A_E_AlarmViewerButtons.iag

* OmronStandardlAG_114A_E_DatalLoggingButtons.iag

* OmronStandardIAG_114A_E_MediaPlayerButtons.iag

* OmronStandardlAG_114A_E_RecipeViewerButtons.iag

* OmronStandardIAG_114A_E_ShowDocumentButtons.iag
* OmronStandardlAG_114A_E_TrendGraphButtons.iag

Project Files (.smc2)

* OmronStandardIAG_114A_E_AlarmButtons.smc2

* OmronStandardlAG_114A_E_AlarmViewerButtons.smc2

* OmronStandardIAG_114A_E_Datal oggingButtons.smc2

* OmronStandardlAG_114A_E_MediaPlayerButtons.smc2

» OmronStandardIAG_114A_E_RecipeViewerButtons.smc2

* OmronStandardlAG_114A_E ShowDocumentButtons.smc2
* OmronStandardIAG_114A_E_TrendGraphButtons.smc2

Ask your OMRON representative for information on how to obtain the files.

3-3 Configuration Units

OMRON implemented the operation check of the libraries using the following system
configuration. The used versions of each library component are also provided.
A Sysmac Studio

project with IAG
objects placed

Transfer of the screen data

Computer NA-series PT
(Sysmac Studio)

Versions of library components used for the operation check are as follows.

* NA OS version :4.2.1
* NA version :1.03
» Sysmac Studio version :1.14
* |IAG library version :1.14A
* Distribution files version : 1.14A
* Project file version :1.14A

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
11



3.Introduction

E{i Precautions for Correct Use

The provided library is a sample, not an OMRON product. The library is out of
OMRON quality assurance coverage.

Before using the library in actual operation, make sure it functions normally with your
machine.

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
12



4.Library Versions

4 Library Versions

This section describes types of IAG library versions appeared in this guide.
The following types of versions are to be managed in order to use the library.

Version type

Description

Version number confirmation
method

Project file
version

Assigns the version number of the project
files that edits and manages the IAG library.
Assigning this version number allows you to
manage the records of library component
additions and removals, and version
updates in individual IAG libraries.

You can check and edit the number
using the IAG project file edit function
in the Sysmac Studio.

Distribution files

Used for the same purpose as the project

You can check the: number using "IAG

version file version. Each distributed IAG file has a Collections Manager" in the Sysmac
unique library version number. Studio.

IAG library Assigns the version number to individual You can check and edit the number

version IAG library. Assigning this version number using the IAG project file edit function
allows you to manage the records of IAG in the Sysmac Studio.
specification changes, bug removals, and You can also check the number as an
other changes. IAG property item using "IAG

Collections Manager". After
placement of a library as an object,
you can check the number from the
"properties” of the object.

NA version The version of the NA-series PT used for the | You can check and edit the number
IAG creation. Each version supports using "Device Type" in the Sysmac
different functions. You cannot use the IAG Studio.
objects with their version numbers indicated
in the properties tables in sections 6 to 12
later than the version number of your PT.

NA OS Version Assigns the version number of the operation | You can check thet NA OS version

system that can operate the runtime of the
NA-series PT. The supported operation
system version depends on the runtime
versions of the PT.

number from NA System Menu. You
can change the NA runtime version of
the project using the Sysmac Studio if
needed.

The versions of the IAG library described in this guide and the supported NA runtime/OS
versions by the IAG library are as follows.

Version type Version Remarks
Project file version | Version 1.14A The project files have a file extension of smc2.
Distribution files Version 1.14A The distribution files have a file extension of iag.
version
IAG library version | Version information is Refer to "Property" in sections 6 to 12.

provided for each library.

NA version

Version 1.03 or later

NA OS Version

Version 4.2.1 or later

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
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5.0verview of IAG Obijects

D Overview of IAG Objects

This section lists IAG objects used for each action.

® Alarm control IAG objects (sample)
IAG file name: "OmronStandardlAG_114A_E_AlarmButtons.iag"

Item

Icon

Description

Reference: Icon appearance
in the NS-series PT

Clear Alarm Log <) Clears the alarm log in non-volatile Not supported.

[Clear_all_user_alarmlog] m‘@ memory.

Check Selected Alarm ‘1)) Checks the selected alarm.

[Acknowledge_the_selected_alarm] e / 1

Check All Alarms Checks all user alarms. < IRy
) AR

[Acknowledge_all_user_alarms] ALt s

® Alarm viewer control IAG objects (sample)
IAG file name: "OmronStandardlAG_114A_E_AlarmViewerButtons.iag"

Item

Icon

Description

Reference: Icon appearance
in the NS-series PT

Scroll Up by Specified Number of
Lines
[Move_up_more_lines]

Scrolls up by the specified number of
lines.

Scroll Down by Specified Number of
Lines
[Move_down_more_lines]

Scrolls down by the specified
number of lines.

« »

Scroll Up One Line
[Move_up_1_line]

Scrolls up one line.

Scroll Down One Line
[Move_down_1_line]

B8 E

Scrolls down one line.

4| |»

® Media Player control IAG objects (Sample)
IAG file name: "OmronStandardIAG_114A_E_MediaPlayerButtons.iag"

[Stop_movie]

specified media player or cancels

Iltem Icon Description Reference: Icon appearance
in the NS-series PT
Play Plays the video registered in the Not supported.
[Play_movie] ﬂ specified media player.
Pause Pauses the video played by the Not supported.
[Pause_movie] m specified media player.
Stop | Stops the video played by the Not supported.

the pause.

14
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5.0verview of IAG Objects

® Recipe control IAG objects (sample)
IAG file name: "OmronStandardIAG_114A_E_RecipeViewerButtons.iag"

Item Icon Description Reference: Icon appearance in
the NS-series PT
Add Record = Adds a new recipe record with
[Add_recipe] — the specified record name to the [3

last line of the recipe record list
in volatile memory.

Delete Record
[Delete_recipe]

Deletes a specified recipe record
from a specified recipe database
file.

Save in Database
[Save_recipe]

i [@

Saves a specified recipe record
that is in volatile memory in a
specified recipe database file.

L | [¥

Save As - Assigns a name to and saves Not supported.
[Save_recipe_as] g—_,'/ (adds) the record selected in the
recipe viewer to the recipe
database.
Import Recipe from External '51 Imports recipe files from external | Not supported.
Storage =] storage into volatile memory.
[Import_recipe]
Export Recipe to External r’“’- Exports recipe files from volatile Not supported.
Storage =] memory to external storage
[Export_recipe]
Write to Controller ]Il Loads the values in the recipe
[Write_recipe_to_controller] g:, fields of the recipe records saved ml
in volatile memory and saves the
values in the controller variables
assigned for a specified recipe
template.
Read from Controller |I| Loads the values in the controller
[Read_recipe_from_controller] u:-" variables assigned for a ﬁl

specified recipe template and
saves the values in the specified
recipe record in volatile memory

® Data logging control IAG objects (sample)
IAG file name: "OmronStandardlAG_114A_E_DataloggingButtons.iag"

Item

Icon

Description

Reference: Icon appearance in
the NS-series PT

Stop Data Logging
[Stop_data_logging]

Stops data logging to the
specified data set.

Start Data Logging
[Start_data_logging]

Starts data logging of the
specified data set.

|

Clear Logged Data
[Clear_datalog_buffer]

BRE

Deletes the logged data of the
specified data set from
non-volatile memory and clears
the display.

LOG
CLR

Write to File
[Export_datalog_buffer]

i

Saves the data that is saved in
non-volatile memory to a file in
external storage.

=il

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
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5.0verview of IAG Obijects

® Trend graph control IAG objects (sample)
IAG file name: "OmronStandardIAG_114A_E_TrendGraphButtons.iag"

Iltem

Icon

Description

Reference: Icon appearance
in the NS-series PT

[Trend_ Scrolldown]

page down.

Scroll Left Scroll left the trend graph display by | Not supported.
[Trend_ScrollForward] single page.
Scroll Right Scroll right the trend graph display by | Not supported.
[Trend_ScrollBack] E single page.
Scroll to Start Position Scrolls the trend graph back to the Not supported.
[Trend_ScrollStart] E| logging start position.
Scroll to End Position Scrolls the trend graph to the most Not supported.
[Trend_ScrollEnd] |@ recent logging data position.
Show/Hide Cursor -y9- Shows/hides the specified cursor. Not supported.
[Trend_DisplayCursor] T
Show/Hide Cursor 1 -y Shows/hides cursor 1. Not supported.
[Trend_DisplayCursor1] T 1
Show/Hide Cursor 2 Y= Shows/hides cursor 2. Not supported.
[Trend_DisplayCursor2] T 2
Display Mode T Selects the display mode of the Not supported.
[Trend_DisplayModeChange] n¥ specified trend graph object (Analog

graph / Digital graph / Both)
Show Analog o Shows only the analog data of the Not supported.
[Set_trend_display_mode_analog] specified trend graph object.
Show Digital A Shows only the digital data of the Not supported.
[Set_trend_display_mode_digital] FRHE specified trend graph object.
Show Both Analog/Digital Data on Shows both the digital and analog Not supported.
[Set_trend_display_mode_both] - data of the specified trend graph

object simultaneously.
Zoom-in Magnifies the view of the specified Not supported.
[Zoom_into trend] @ trend graph, centered at the center of

the display.
Zoom-out Reduces the view of the specified Not supported.
[Zoom_out_trend] trend graph, centered at the center of

the display.
Scroll Up Scrolls the specified trend graph one | Not supported.
[Trend_ Scrollup] EA page up.
Scroll Down Scrolls the specified trend graph one | Not supported.

v
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5.0verview of IAG Objects

® Document Viewer control IAG objects (sample)
IAG file name: "OmronStandardIAG_114A_E_ShowDocumentButtons.iag"

Item

Icon

Description

Reference: Icon appearance
in the NS-series PT

Show Document E )| | Displays a specified document at a Not supported.
[Show_document] specified size (length and width).

Show Document (Full Screen) ", 7 Displays the specified document in Not supported.
[Show_document_full_screen] lk'al full-screen mode.

® Compound IAG objects (sample)
Combinations of multiple control objects (compound IAG objects) are also provided as a
part of the sales promotion sample IAG library. These objects eliminate the needs of the
property settings and simplify the controls of each function.

IAG file name: "OmronStandardIAG_114A_E_AlarmButtons.iag"

Item

Icon

Description

Alarm control compound object
[Alarm_composition_all]

) ‘ ’)?/

—
B

[Clear Alarm Log]

[Check Selected Alarm]
[Check All Alarms]
Comipound IAG consisting of
three objects.

IAG file name:

"OmronStandardlAG_114A_E_AlarmViewerButtons.iag"

Iltem

Icon

Description

Alarm viewer control compound
object
[Scroll_compsition_all]

[Return to Top]

[Scroll Up by Specified
Number of Lines]

[Scroll Up One Line]

[Scroll Down One Line]
[Scroll down by the specified
amount of lines]

[Go to End]

Comipound IAG consisting of
six objects.

IAG file name: " OmronStandardIAG_114A_E_MediaPlayerButtons.iag"

Item

Icon

Description

Media Player Compound Object
[Media_player_compotision__all]

[Stop]

[Play]

[Pause]

Comipound IAG consisting of
three objects.

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
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IAG file name: "OmronStandardIAG_114A_E_RecipeViewerButtons.iag"

Item Icon Description
Recipe control r ) [Add Record]
compound object = ‘% [Save]

[Recipe - [Save As]

Composition] [Delete]
[Import]
[Export]

[Read from Controller]

[Write to Controller]
Compound IAG consisting of
eight objects.

IAG file name: "OmronStandardIAG_114A_E_DataloggingButtons.iag"

Item

Icon

Description

Data logging
compound object
[Datalog_compositi
on]

[Start Data Logging]

[Stop Data Logging]

[Clear Logged Datal

[Save logged data]
Compound IAG consisting of
four objects.

IAG file name: "OmronStandardIAG_114A_E_TrendGraphButtons.iag"

Item

Icon

Description

Trend Graph
Control (Horizontal
Axis) Compound
Object
[Trend_graph_
composition_all]

[Scroll to Start Position]
[Scroll Left]

[Scroll Right]

[Scroll to End Position]
[Show/hide cursor 1]
[Show/hide cursor 2]
[Show/hide analog data]
[Show/hide digital data]
Compound IAG consisting of
eight objects.

Trend Graph
Control (Vertical
Axis) Compound
Object
[Trend_graph_com
psiton2]

[Scroll Up]

[Scroll Down]

[Zoom-in]

[Zoom-out]

Compound IAG consisting of
four objects.

IAG file name: "OmronStandardIAG_114A_E_ShowDocumentButtons.iag"

Item

Icon

Description

Document Viewer
control compound
objects
[Document_viewer
_composition_all]

[Show Document]

[Show Document (Full
Screen)]

Compound IAG consisting of
two objects.
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6.1AG for Alarm Control

O IAG for Alarm Control

6-1 Clear Alarm Log

® External specification

Object name

Clear_all_user_alarmlog

Category IAG_Alarm
Description Clears the alarm log in non-volatile memory.
Features Clears not only a single specific alarm, but also all the other alarm data saved in the
NA-series PT.
Graphic expression o)) \
»u'lfu'
Not pressed:
"
ALy
Pressed:
® Properties
Property Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Clear_all_user_alarmlo
that screen. characters) g0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent *1
Direct input String
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical

Properties screen

¥ General

Name Clear_all_user_alarmlog0

Type

Version

Publisher
v Appearance
BackgroundColor
¥ Layout
Position (Left, Top)

Size (Width,Height)

Width

Height
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6.1AG for Alarm Control

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.

=
Additional Information
This IAG does not have a "Behavior (Input)" property.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtIOI’] . Ani 2 < Select Animation te Add >

For details, refer to "Animations".

Move

ResizeHeight
ResizeWidth
Visibility
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6.1AG for Alarm Control

6-2 Check Selected Alarm

® External specification

Object name

Acknowledge_the_selected_alarm

Category IAG_Alarm
Description Checks the selected alarm.
Features Checks the alarm selected in the alarm viewer specified by AlarmObjectName.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Acknowledge_the_sele
that screen. characters) cted_alarmO
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. -—- - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2. Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjectName Specifies the alarm viewer object name. Direct input Character string (Blank)

(String)*3

Properties screen

¥ General

Name

Acknowladge_the_selected_alarmo

Type

Version

Publisher

¥ Appearance
BackgroundColor
Layout
Position (Left, Top)

Left

Size (Width,Height)

Width

Height
Behavior (Input)

AlarmObjName
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6.1AG for Alarm Control

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

ey
Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjectName" property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtIOI’] . imations < Select Animation te Add >

For details, refer to "Animations".

Move

ResizeHeight

ResizeWidth
Visibility
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6.1AG for Alarm Control

6-3 Check All Alarms

® External specification

Object name

Acknowledge_all_user_alarms

Category IAG_Alarm
Description Checks all alarms.
Features Checks all NA unit alarms.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Acknowledge_all_user_
that screen. characters) alarms0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical

Properties screen

¥ General
Name

Acknowladge_all_user_alarms0

Type IAG

Version 1.0

Publisher Omron
¥ Appearance
BackgroundColor
Layout
Position (Left, Top)

[] Transparent -

Left

Size {Width,Height)

Width

Height

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
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6.1AG for Alarm Control

=8 Additional Information
This IAG does not have a "Behavior (Input)" property.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

Acknowladge_all_user_alarms0
aCtlon . imations < Select Animation to Add >

For details, refer to "Animations". Mave

ResizeHeight

ResizeWidth
Visibility
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7.Alarm Viewer Control IAG

[ Alarm Viewer Control IAG

7-1 Scroll Up by Specified Number of Lines

® External specification

Object name

Move_up_more_lines

Category IAG_Alarm
Description Scrolls up by the specified number of lines.
Features Scrolls the alarm viewer specified in AlarmObjectName up by the number of lines specified

in ViewerScrollAmount.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Move_up_more_lines0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjName Specifies the alarm viewer object name. Direct input Character string (Blank)
(String)
*3
ViewerScrollAmount Specifies the number of alarm viewer scroll lines. Direct input Numerical (Blank)
(Integer)

Properties screen
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7 .Alarm Viewer Control IAG

¥ General
Name Move_up_more_lines0
Type
Version

Publisher
¥ Appearance
BackgroundColor

¥ Layout
¥ Position (Left, Top)

Left

Top

¥ Size (Width,Height)
Width

Height
¥ Behavior (Input)
AlarmObjName

ViewerScrollAmount

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

=8 Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjName" and "ViewerScrollAmount" properties. A build error will occur if not
entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtion . Animal < Salect Animation to Add >

For details, refer to "Animations". i

ResizeHeight
ResizeWidth
Visibility
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7.Alarm Viewer Control IAG

7-2 Scroll Down by Specified Number of Lines

® External specification

Object name

Move_down_more_lines

Category IAG_Alarm
Description Scrolls down by the specified number of lines.
Features Scrolls the alarm viewer specified in AlarmObjectName down by the number of lines

specified in ViewerScrollAmount.

Graphic expression

Not pressed: ﬂ

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Move_down_more_line
that screen. characters) sO
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjName Specifies the alarm viewer object name. Direct input Character string (Blank)
(String)
*3
ViewerScrollAmount Specifies the number of alarm viewer scroll lines. Direct input Numerical (Blank)
(Integer)

Properties screen
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7 .Alarm Viewer Control IAG

¥ General
Name Move_down_more_lines0
Type

Version

Publisher
v Appearance

BackgroundColor

¥ Layout
¥ Position (Left, Top)
Left

Top

¥ Size (Width,Height)
Width

Height
¥ Behavior (Input)
AlarmObjName

ViewerScrollAmount

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjName" and "ViewerScrollAmount" properties.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtlon . Animations < Select Animation to Add >
For details, refer to "Animations". jiove

ResizeHeight
ResizeWidth
Visibility
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7.Alarm Viewer Control IAG

7-3 Scroll Up One Line

® External specification

Object name

Move_up_1_line

Category IAG_Alarm
Description Scrolls up one line.
Features Scrolls the alarm viewer specified in AlarmObjectName up one line.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Move_up_1_line0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjName Specifies the alarm viewer object name. Direct input Character string (Blank)

(String)
*3

Properties screen

v General
Name

Move_up_1_line0

Type

Version

Publisher
¥ Appearance
BackgroundColor
¥ Layout

¥ Position (Left, Top)

Left

¥ Size (Width,Height)

Width

Height
¥ Behavior (Input)
AlarmObjName
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7 .Alarm Viewer Control IAG

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjName" property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

Move_up_1_line0
aCt|0n . < Select Animation to Add >

For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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7.Alarm Viewer Control IAG

7-4 Scroll Down One Line

® External specification

Object name Move_down_1_line

Category IAG_Alarm

Description Scrolls down one line.

Features Scrolls the alarm viewer specified in AlarmObjectName down one line.

Graphic expression

Not pressed; &=

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Move_down_1_line0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjName Specifies the alarm viewer object name. Direct input Character string (Blank)
(String)
*3

Properties screen

Name Move_down_1_lined

Type IAG

Version 1.0

Publisher
v AR
LAfFPIk
Position {Left, Top)
Left

Top
Size (Width,Height)
Width

Height
ANEE

AlarmObjName
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7 .Alarm Viewer Control IAG

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjName" property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
i Move_down_1_line0
aCt|0n . < Select Animation to Add >

For details, refer to "Animations".

Move

ResizeHeight

ResizeWidth
Visibility
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7.Alarm Viewer Control IAG

7-5 Return to Top

® External specification

Object name

Return_to_the_top_of Alarm_List

Category IAG_Alarm
Description Returns to the top of the alarm list.
Features Included in alarm viewer control compound object [Scroll_compsition_all].

For details, refer to "13-2 Alarm Viewer Control Compound Object".

Graphic expression

Not pressed: E

———————

A

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 ---
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjName Specifies the alarm viewer object name. Direct input Character string (Blank)

(String)
*3

Properties screen
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7.Alarm Viewer Control IAG

¥ General

Name Scroll_composition_all0

Type

Version

Publisher

¥ Appearance

Layout
Position (Left, Top) 30, 130
Left 30

Top
Size (Width,Height)
Width
Height
Behavior (Input)
AlarmObjName

ViewerScrollAmount

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjName" property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCt|on Ani 14 - < Select Animation to Add >

For details, refer to "Animations". slsis

ResizeHeight

ResizeWidth
Visibility
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7.Alarm Viewer Control IAG

7-6 Go to End

® External specification

Object name

Go_to_the _end_of Alarm_List

Category IAG_Alarm
Description Moves to the end of the alarm list.
Features Included in alarm viewer control compound object [Scroll_compsition_all].

For details, refer to "13-2 Alarm Viewer Control Compound Object".

Graphic expression

Not pressed:

\ N
Pressed:

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 ---
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
AlarmObjName Specifies the alarm viewer object name. Direct input Character string (Blank)

(String)
*3

Properties screen
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7.Alarm Viewer Control IAG

¥ General
Name Scroll_composition_all0

Type IAG

Version 1.0

Publisher Omron

¥ Appearance

Layout
Position (Left, Top) 30, 130
Left 30

Top

Size (Width,Height)
Width

Height
Behavior (Input)
AlarmObjName

ViewerScrollAmount

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

ey
Additional Information
When positioning an alarm on the page as an object, you must enter the
"AlarmObjName" property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
action. .
For details, refer to "Animations". Animations. | <select Animation to Add >

Move

ResizeHeight
ResizeWidth
Visibility
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8.Media Player Control IAG

8 Media Player Control IAG

8-1 Play

® External specification

Object name Play_movie

Category IAG_Movie

Description Plays the video registered in the specified media player.
Features Can also resume a video that was stopped or paused.

Graphic expression

Not pressed:

—

=

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Play_movie0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
MovieObjName Specifies the media player object name. Direct input Character string (Blank)

(String)
*3

Properties screen
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8.Media Player Control IAG

¥ General
Name Play_movie0

Type
Version

Publisher
v Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)
Left

Top
¥ Size (Width,Height)
Width

Height
¥ Behavior (Input)
MovieQbjName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

Additional Information
When positioning on the page as an object, you must enter the "MovieObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtion. 3 na < Select Animation to Add >
For details, refer to "Animations". Mdye

ResizeHeight
ResizeWidth
Visibility

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
38



8.Media Player Control IAG

8-2 Pause

® External specification

Object name

Pause_movie

Category IAG_Movie
Description Pauses the video played by the specified media player.
Features

Pauses the video played by the media player specified in "MovieObjName".

Graphic expression

Not pressed: J

[nf

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Pause_movie0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
MovieObjName Specifies the media player object name. Direct input Character string (Blank)

(String)
*3

Properties screen

¥ General

Name Pause_movie0

Type

Version

Publisher
¥ Appearance
BackgroundColor

¥ Layout

Position (Left, Top)

Left

Top

Size (Width,Height)

Width

Haeight
¥ Behavior (Input)
MovieObjName
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning on the page as an object, you must enter the "MovieObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

Pause_moviel
aCt|0n . i s < Select Animation to Add >

For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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8-3 Stop

® External specification

Object name Stop_movie

Category IAG_Movie

Description Stops the video played by the specified media player or cancels the pause.
Features Stops the video played by the media player specified in "MovieObjName".

If replayed, playback starts from the beginning of the video.

Graphic expression

il

Not pressed:

[mf

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Stop_movie0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
MovieObjName Specifies the media player object name. Direct input Character string (Blank)

(String)
*3

Properties screen

v General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)
Left
Top
¥ Size (Width,Height)
Width
Height

¥ Behavior (Input)
MovieObjName

Stop_movie0

IAG
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning on the page as an object, you must enter the "MovieObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtIOI’] natiof « Select Animation to Add >

For details, refer to "Animations".

Move

ResizeHeight
ResizeWidth
Visibility
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9 Recipe Control IAG

9-1 Add Record

® External specification

Object name Add_recipe
Category IAG_Recipe
Description Adds a new recipe record with the specified record name to the last line of the recipe
record list in volatile memory.
Features "Add" accesses the recipe record in volatile memory.
Graphic expression =
o—
Not pressed:
—n
L]
Pressed:
® Properties
Property Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Add_recipe0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. -—- - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)

(String)
*3

Properties screen
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v General

MName

Type
Version 1.0

Publisher Omron

¥ Appearance

¥ Layout

¥ Position (Left, Top) 190, 130

Left 190
Top 130
Size (Width,Height)
Width
Height
¥ Behavior (Input)
RecipeObjName

MNewInstanceName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "RecipeObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

aCtion. Animations < Select Animation to Add >
For details, refer to "Animations". Wive

ResizeHeight
ResizeWidth
Visibility
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9-2 Delete Record

® External specification

Object name

Delete_recipe

Category IAG_ReCipe
Description Deletes the recipe record selected in the recipe viewer from the recipe database file.
Features

"Delete" accesses the specified recipe database file in non-volatile memory.

Graphic expression

Not pressed:

=i (il

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Delete_recipe0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)

(String)
*3

Properties screen

¥ General

Name

Delete_recipe0

Type IAG

Version

Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)

Left

Top

¥ Size (Width,Height)

Width

Height

¥ Behavior (Input)

RecipeObjName
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning on the page as an object, you must enter the "RecipeObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtion . i < Select Animation to Add >

For details, refer to "Animations".

Delete_recipe0

Move
ResizeHeight
ResizeWidth
Visibility
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9-3 Save in Database

® External specification

Object name Save_recipe

Category IAG_Recipe

Description Saves the recipe record selected in the recipe viewer in the database.
Features

"Save" indicates the action of writing data from volatile memory to non-volatile memory.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Save_recipe0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
¥ Layout

Position (Left, Top)
Left

Top
Size (Width,Height)
Width
Height
¥ Behavior (Input)
RecipeObjName

Save_recipe0

*1. "Transparent" indicates that the color is transparent.

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)

47



9.Recipe Control IAG

*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "RecipeObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

Save_recipe0
action. < Select Animation to Add >

For details, refer to "Animations". s

ResizeHzight
ResizeWidth
Visibility
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9-4 Save As

® External specification

Object name Save_recipe_as

Category IAG_Recipe

Description Assigns a name to and saves (adds) the record selected in the recipe viewer to the recipe
database.

Features "Save" indicates the action of writing data from volatile memory to non-volatile memory.

The recipe with the new name is added to the last line of the recipe database file.
The data in the saved (added) record is the same as the data in the selected record.

Graphic expression I":

5

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Save_recipe_as0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)
(String)
*3

Properties screen
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

-
Additional Information
When positioning on the page as an object, you must enter the "RecipeObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

aCtion . Ani s < Select Animation to Add >
For details, refer to "Animations". Moye

ResizeHeight
ResizeWidth
Visibility
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9-5 Import Recipe from External Storage

® External specification

Object name

Import_recipe

Category IAG_Recipe
Description Imports a recipe file saved in external storage into non-volatile memory.
Features "Import" indicates the action of writing data from external storage to non-volatile memory.

list in non-volatile memory.

All recipe records saved in the file in external storage are imported into the recipe record

Graphic expression Rs;
Not pressed:
B
B=
Pressed:
® Properties
Property Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 | Import_recipeO
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | specifies the position of the object on the page.* *2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of | Direct input Numerical -
the position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the | Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)
(String)
*3
PathAndFileName Import file path and file name *4 Direct input Character string (Blank)
(String)
*3

Properties screen
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¥ General

Name Import_recipe0
Type IAG

Version 1.0

Publisher Omron

¥ Appearance

¥ Layout

¥ Position (Left, Top) 240, 490
Left

Top

¥ Size (Width,Height)

Width

Height
¥ Behavior (Input)

RecipeObjName
PathAndFileName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
*4. The import file path and file name are as follows:
Import file path_SD card: \SDCard\Folder name\File name
_USB memory: \USBDisk\Folder name\File name
Example: SDCard\Recipe0.csv: Imports from "Recipe.csv" file in root directory of SD card

=
Additional Information

When positioning on the page as an object, you must enter the "RecipeObjName" and
"PathAndFileName" properties.
A build error will occur if not entered.

® Event and action

There are no event and action functions.

® Animation

You can define the basic animation

action.

< Sefect Animation to Add >

For details, refer to "Animations". e Move
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Visibility
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9-6 Export Recipe to External Storage

® External specification

Object name

Export_recipe

Category IAG_Recipe
Description Exports the recipe template data selected in the recipe viewer to external media.
Features "Export" indicates the action of writing data from non-volatile memory to external storage.

All recipe records in non-volatile memory are exported to the external storage file.
Specify the export path and file name with the "PathAndFileName" property.

Graphic expression

Not pressed: =

pRS
B=
Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Export_recipe0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2. Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)
(String)
*3
PathAndFileName Specifies the export path and file name. Direct input Character string (Blank)
*4 (String)
*3

Properties screen
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Height
¥ Bahavior (Input)

*1. "Transparent" indicates that the color is transparent.

*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

*4. The export file path and file name are as follows:
Export file path_SD card: \SDCard\Folder name\File name
_USB memory: \USBDisk\Folder name\File name

Example: SDCard\Recipe0.csv: Exports to "Recipe.csv" file in root directory of SD card

=
Additional Information

When positioning on the page as an object, you must enter the "RecipeObjName" and
"PathAndFileName" properties.

A build error will occur if not entered.

® Event and action

There are no event and action functions.

® Animation

You can define the basic animation

action.
For details, refer to "Animations".
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Move

ResizeHaight
ResizeWidth
Visibility
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9-7 Write to Controller

® External specification

Object name

Write_recipe_to_controller

Category IAG_Recipe
Description Writes the recipe data selected in the recipe viewer to the applicable variable.
Features The variable name and controller written to are specified in the template.

Graphic expression

!

Not pressed:

™

e

o—
Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Export_recipe0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)

(String)
*3.

Properties screen

¥ General

Name

‘Write_recipe_to_controllero

Type IAG

Version

Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)

Left

Top

¥ Size (Width,Height)

Width

Height

¥ Behavior (Input)
RecipeObjName
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

-
Additional Information
When positioning on the page as an object, you must enter the "RecipeObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

Write_recipe_to_controllerd
action. < Select Animation to Add >

For details, refer to "Animations". Marves

ResizeHeight
ResizeWidth
visibility
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9-8 Read from Controller

® External specification

Object name

Read_recipe_from_controller

Category IAG_Recipe
Description Reads the recipe data selected in the recipe viewer from the applicable variable.
Features The variable name and controller read from are specified in the template.

Graphic expression

I I
Not pressed: J

e
s
Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Read_recipe_from_con
that screen. characters) troller0
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)

(String)
*3

Properties screen

¥ General

Type

Version

Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)

Left

¥ Size (Width,Height)

Width

Height
¥ Behavior (Input)

RecipeObjName
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning on the page as an object, you must enter the "RecipeObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtIOI’] nimatic g < Select Animation to Add >
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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10 Data Log Control IAG

10-1 Stop Data Logging

® External specification

Object name Stop_data_logging
Category IAG_Trend
Description Stops data logging to the specified data set.

Features Stops acquiring data and stops drawing the trend graph.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Stop_data_logging0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
SelectDataSetName Specifies the name of the data set for logging. Direct input Character string (Blank)
(String)
*3

Properties screen
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¥ Behavior (Input)
athame

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

-
Additional Information
When positioning on the page as an object, you must enter the "SelectDataSetName "
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

Animations > Ox
Stop_data_logging0

You can define the basic animation

aCtlon. < Select Animation to Add > v

For details, refer to "Animations". Move
ResizeHeight

ResizeWidth
Visibility
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10-2 Start Data Logging

® External specification

Object name Start_data_logging
Category IAG_Trend
Description Starts data logging of the specified data set.

Features Starts acquiring data and starts drawing the trend graph.

Graphic expression @
Not pressed:

Fo

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Start_data_logging0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
SelectDataSetName Specifies the name of the data set for logging. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General

Name Start_data_logging0

Type IAG

Version

Publishar
¥ Appearance
BackgroundColor
¥ Layout

Position {Left, Top)
Left

Top

Size (Width,Height)
Width
Height
¥ Behavior (Input)
SelectDataSetName

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
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—
Additional Information
When positioning on the page as an object, you must enter the "SelectDataSetName "
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation

Animations = el b
t' Start_data_logging0
action. nir 5 < Select Animation to Add >

For details, refer to "Animations". Move
ResizeHeight

ResizeWidth
Visibility
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10-3 Clear Logged Data

® External specification

Object name Clear_datalog_buffer

Category IAG_Trend

Description Deletes the logged data of the specified data set from non-volatile memory and clears the
display.

Features Deletes the logged data of the data set specified in SelectDataSetName.

Logged data exported to a CSV file is not deleted.

Graphic expression %
Not pressed:

——————

L

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Clear_datalog_buffer0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
SelectDataSetName Specifies the name of the data set for logging. Direct input Character string (Blank)
(String)
*3

Properties screen
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¥ General
Name Clear_datalog_buffero

Type IAG

Version 1.0

Publisher
¥ Appearance
¥ Layout
¥ Position (Left, Top)

Left

Top
¥ Size (Width,Height)
Width

Height
¥ Behavior (Input)
SelectDataSetName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

—
Additional Information
When positioning on the page as an object, you must enter the "SelectDataSetName "
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation .
t. Clear_datalog_buffer0
action. Anirr . < Select Animation to Add >
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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10-4 Write to File

® External specification

Object name Export_datalog_buffer

Category IAG_Trend
Description Saves the data that is saved in non-volatile memory to a file in external storage.
Features The location to which the file is exported is the location specified in the "Save to" setting of

the data set.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Export_datalog_buffer0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
SelectDataSetName Specifies the name of the data set for logging. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name

Backgrol
¥ Layout
¥ Pusition (Left, Top)
Left

alth, Height)
dth
Height
v B v (Tnpat)
SelectDataSetName

Export_datalog_buffero

*1. "Transparent" indicates that the color is transparent.

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
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*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "SelectDataSetName "
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

Numatlnm =
Export_datalog_buffer0

You can define the basic animation

action. imatio < Select Animation to Add > -
For details, refer to "Animations". Move
ResizeHeight

ResizeWidth
Visibility
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11 Trend Graph Control IAG

11-1 Scroll Right

® External specification

Object name

Trend_ScrollForward

Category IAG_Trend
Description Scrolls the trend graph to the right (toward most recent data).
Features Scrolls the trend graph specified in TrendObjName to the right.

Graphic expression

Not pressed: J

£2

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_ScrollForward0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. -—- - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen
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¥ General
Name Trend_ScrollForward0

Type

Version

Publisher
¥ Appearance

BackgroundColor

¥ Layout
¥ Position (Left, Top)
Left

Top

¥ Size (Width,Height)
Width

Height
¥ Behavior (Input)
TrendObjName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

=
Additional Information

When positioning on the page as an object, you must enter the "TrendObjName"

property.

A build error will occur if not entered.

® Event and action

There are no event and action functions.

® Animation
You can define the basic animation -
. Trend_ScrollForward0
aCtlon' < Select Animation to Add >
For details, refer to "Animations". Move
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ResizeHeight
ResizeWidth
Visibility
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11-2 Scroll Left

® External specification

Object name

Trend_ScrollBack

Category IAG_Trend
Description Scrolls the trend graph to the left (ftoward oldest data).
Features

Scrolls the trend graph specified in TrendObjName to the left.

Graphic expression

Not pressed: J

k=

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_ScrollBackO
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
¥ Layout
Position (Left, Top)
Left
Top
Size (Width,Height)
Width
Height

¥ Behavior (Input)
TrendObjName

Trend_ScrollBack0
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation .
Trend_ScrollBackd

action. < Select Animation to Add > .
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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11-3 Scroll to Start Position

® External specification

Object name Trend_ScrollStart
Category IAG_Trend
Description Scrolls the trend graph back to the logging start position.
Features Scrolls the trend graph specified in TrendObjName to the logging start position.
Graphic expression @
Not pressed:
B
Pressed: -
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_scrollStart0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name Trend_ScrollStart0
Type
Version

Publisher

¥ Appearance
BackgroundColor
¥ Layout
Position (Left, Top)
Left

Top

Size (Width,Height)
Width

Height

¥ Behavior (Input)
TrendObjName

*1. "Transparent" indicates that the color is transparent.
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*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation Animations. ~ 0%
t_ Trend_ScrollStart0

action. ations < Select Animation to Add = b4
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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11-4 Scroll to End Position

® External specification

Object name

Trend_ScrollEnd

Category IAG_Trend
Description Scrolls the trend graph to the most recent logging data position.
Features

Scrolls the trend graph specified in TrendObjName to the most recent logging position.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_ScrollEnd0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
¥ Layout

¥ Position (Left,Top)

Left
Top
¥ Size (Width,Height)
Width
Height
¥ Behavior (Input)
TrendObjName

Trend_ScrollEnd0

*1. "Transparent" indicates that the color is transparent.
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*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

Animations - 0 x
Trend_ScrollEnd0

You can define the basic animation

action. < Select Animation to Add =
For details, refer to "Animations". Move
ResizeHeight

ResizeWidth
Visibility
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11-5 Show/Hide Cursor

® External specification

Object name

Trend_DisplayCursor

Category IAG_Trend
Description Shows/hides the specified cursor.
Features Shows the cursor specified in the properties.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_DisplayCursor0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection | Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3
CursorNo Specified show/hide cursor number Direct input Numerical (Blank)
*4 (Integer)
CursorVisible Specifies cursor show/hide Direct input Numerical (Blank)
*5 (Boolean)

Properties screen
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¥ General

Name Trend_DisplayCursor0

Type 1AG

Version 1.0

Publisher

¥ Appearance
BackgroundCalor
¥ Layout
Position (Left, Top)
Left

Top
Size (Width,Height)
Width

Height

¥ Behavior (Input)
TrendObjName

CursorNo

CursorVisible

*1.
*2.
*3.
*4.

*5.

"Transparent” indicates that the color is transparent.

The coordinate origin is the upper-left corner of the NA-series PT screen.

When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
Select 1,2, 0r 3

1: Show Cursor 1 only

2: Show Cursor 2 only

3: Show both Cursor 1 and Cursor 2

Specify a Boolean variable.

When the Boolean variable is "True", the cursor is shown. When "False", the cursor is hidden.
"0" or "1" can be entered instead of "True" or "False".

"0" is the equivalent of "False", and "1" is the equivalent of "True".
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-
Additional Information
When positioning on the page as an object, you must enter the "TrendObjName",
"CursorNo", and "CursorVisible" properties.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
aCtlon' < Select Animation to Add = v
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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11-6 Show/Hide Cursor 1

® External specification

Object name

Trend_DisplayCursor1

Category IAG_Trend
Description Shows/hides cursor 1.
Features The specified cursor is fixed at Cursor 1.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_DisplayCursor10
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3
CursorVisible Specifies cursor show/hide Direct input Numerical (Blank)
*4 (Boolean)

Properties screen
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v General

Name Trend_DisplayCursor10

Type IAG

Version 1.0

Publisher
v Appearance
¥ Layout
Position {(Left, Top)
Left

Top

Size (Width,Height)
Width

Height
¥ Behavior (Input)
TrendObjName

CursorVisible

*1.
*2.
*3.
*4.

"Transparent" indicates that the color is transparent.

The coordinate origin is the upper-left corner of the NA-series PT screen.

When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
Specify a Boolean variable.

When the Boolean variable is "True", the cursor is shown. When "False", the cursor is hidden.

"0" or "1" can be entered instead of "True" or "False".

"0" is the equivalent of "False", and "1" is the equivalent of "True".
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sy
Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
aCtlon' : < Select Animation to Add > v
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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11-7 Show/Hide Cursor 2

® External specification

Object name

Trend_DisplayCursor2

Category IAG_Trend
Description Shows/hides cursor 2.
Features The specified cursor is fixed at Cursor 2.

Graphic expression

Not pressed:

Pressed:
® Properties
Property I Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_DisplayCursor20
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. ltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3
CursorVisible Specifies cursor show/hide Direct input Numerical (Blank)
*4 (Boolean)

Properties screen
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¥ General

Name Trend_DisplayCursor20

Type IAG

Version 1.0

Publisher

¥ Appearance

¥ Layout

¥ Position (Left, Top)

Left

Top

¥ Size (Width,Height)

Width

Height
¥ Behavior (Input)
TrendObjName

CursorVisible

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
*4. Specify a Boolean variable.
When the Boolean variable is "True", the cursor is shown. When "False", the cursor is hidden.
"0" or "1" can be entered instead of "True" or "False".
"0" is the equivalent of "False", and "1" is the equivalent of "True".

-
Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
action. { < Select Animation to Add >
For details, refer to "Animations". Move

ResizeHeight
ResizeWidth
Visibility
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11-8 Display Mode

® External specification

Object name

Trend_DisplayModeChange

Category IAG_Trend
Description Selects the display mode of the specified trend graph object
(Analog graph / Digital graph / Both)
Features Selects the display mode of the trend graph specified in TrendObjName.
Graphic expression Fav
int
Not pressed
e
St
Pressed
® Properties
Property I Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_DisplayModeCh
that screen. characters) ange0
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3
DisplayMode Specifies the trend graph display mode Direct input Numerical (Blank)
*4 (Integer)

Properties screen
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¥ General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)
Left
Top
¥ Size (Width,Height)
Width
Height
¥ Behavior (Input)
TrendObjName
DisplayMode

Trend_DisplayModeChange0

IAG

1.0

[ Transparent -

*1.
*2.

"Transparent” indicates that the color is transparent.

The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

*4. Specify an Integer variable. Enter one of the values below to select the display mode.

Select 0, 1, or 2
0: Analog only
1: Digital only
2: Both

82
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Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

Trend_DisplayModeChange0

You can define the basic animation

action. Animations < Select Animation to Add > =
For details, refer to "Animations". Mova
ResizeHeight

ResizeWidth
Visibility
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11-9 Show Analog

® External specification

Object name

set_trend_display_mode_analog

Category IAG_Trend
Description Shows only the analog data of the specified trend graph object.
Features Shows only the analog (numerical) data of the trend graph specified in TrendObjName.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 set_trend_display_mod
that screen. characters) e_analog0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left,Top)
Left
Top
¥ Size (width,Height)
Width
Height:
¥ Behavior (Input}
TrendObjName

Set_trend_display_mode_analog0

IAG

1.0

Omron

["] Transparent #

*1. "Transparent" indicates that the color is transparent.
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*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation Animations - Ox
t. Set_trend_display_mode_analog0
action. < Select Animation to Add > =

For details, refer to "Animations". Move
ResizeHeight

ResizeWidth
Visibility

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
84



11.Trend Graph Control IAG

11-10 Show Digital

® External specification

Object name

set_trend_display_mode_digital

Category IAG_Trend
Description Shows only the digital data of the specified trend graph object.
Features Shows only the digital (Boolean) data of the trend graph specified in TrendObjName.

Graphic expression

Not pressed:

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 set_trend_display_mod
that screen. characters) e_digital0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name
Typer
Version
Fublisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Pomition (Left, Top)

Width
Height
¥ Behavior (Input)
TrendOhjName

Set_trend_display_meode_digitalo

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
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Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
aCtlon' < Select Animation to Add > -
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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11-11 Show Both Analog and Digital

® External specification

Object name

set_trend_display_mode_both

Category IAG_Trend
Description Selects the display mode of the trend graph.
Features Shows both the analog graph and the digital graph.

Graphic expression

Not pressed

o
alht
Pressed
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 set_trend_display_mod
that screen. characters) e_both0
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection | Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General
Name
Type
Version
Publisher
¥ Appearance
BackgroundColor
Layout
Position (Left, Top)
Left
Top
Size (Width,Height)
Width

Height
Behavior (Input)
TrendObjName

Set_trend_display_mode_both0
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

action. nimati < Select Animation to Add > =

For details, refer to "Animations". Mova
ResizeHeight

ResizeWidth
Visibility
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11-12 Zoom-in

® External specification

Object name

zoom_into_trend

Category IAG_Trend
Description Magnifies the view of the specified trend graph, centered at the center of the display.
Features Only effective for trend graph objects.

The zoom-in direction can be specified in the properties. (X-axis only, Y-axis only, Both X-

and Y- axes)

Graphic expression

Not pressed: J

R

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 zoom_into_trend0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection | Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)*3
ZoomTarget Specifies the zoom-in direction Direct input Numerical (Blank)
*4 (Integer)

Properties screen

Zoom_into_trendo

Width, Hesght)

Height
¥ Bahavior (Input)
TrandObjiame

ZoomTanget
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. "Transparent" indicates that the color is transparent.
*2.
*3.
*4.

The coordinate origin is the upper-left corner of the NA-series PT screen.

When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
Specify an Integer variable. Enter one of the values below to select the zoom-in setting.

Select 0, 1, or 2

0: Both Zoom-in both X- and Y-axes

1: X-axis Zoom-in X-axis

2: Y-axis Zoom-in Y-axis

90
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Additional Information

When positioning on the page as an object, you must enter the "TrendObjName" and
"ZoomTarget" properties.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

Animations > 0O x
Zoom_into_trend0

You can define the basic animation

aCtlon ) < Select Animatien to Add =
For details, refer to "Animations". Move
ResizeHeight

ResizeWidth
Visibility
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11-13 Zoom-out

® External specification

Object name

zoom_out_trend

Category IAG_Trend
Description Reduces the view of the specified trend graph, centered at the center of the display.
Features Only effective for trend graph objects.

X-and Y- axes)

The zoom-out direction can be specified in the properties. (X-axis only, Y-axis only, Both

Graphic expression

Not pressed:

—

Q

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 zoom_out_of_trendO
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)3
ZoomTarget Specifies the zoom-out direction Direct input Numerical (Blank)
*4 (Integer)

Properties screen

Zoom_out_of_trenda
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*1.
*2.
*3.
*4.

"Transparent" indicates that the color is transparent.

The coordinate origin is the upper-left corner of the NA-series PT screen.

When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
Specify an Integer variable. Enter one of the values below to select the zoom-out setting.

Select 0, 1, or 2

0: Both Zoom-out both X- and Y-axes

1: X-axis Zoom-out X-axis

2: Y-axis Zoom-out Y-axis
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Additional Information

When positioning on the page as an object, you must enter the "TrendObjName" and
"ZoomTarget" properties.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
aCtion' < Select Animation to Add = -
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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11-14 Scroll Up

® External specification

Object name

Trend_Scrollup

Category IAG_Trend
Description Scrolls the specified trend graph one page up.
Features Only effective when the view is magnified.

Graphic expression

Fal
Not pressed:

Pressed: [F—A

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_Scrollup0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. -—- - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)*3

Properties screen

¥ General
Name
Type
Version
Publisher

¥ Appearance
BackgroundColer

¥ Layout

Position (Left, Top)

Left
Top
Size (Width Height)
Width
Height
¥ Behavior (Input)
TrendObjName

Trend_Scrollup0

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
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Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

action. i 1 < Select Animation to Add >
For details, refer to "Animations". - Move

ResizeHeight

ResizeWidth

Visibility

Trend_Scrollup0
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11-15 Scroll Down

® External specification

Object name Trend_Scrolldown

Category IAG_Trend
Description Scrolls the specified trend graph one page down.
Features Only effective when the view is magnified.

Graphic expression

Not pressed: ¢

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_ScrolldownO
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. ltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)*3

Properties screen

¥ General

Name Trend_Scrolldown0

Type IAG

Version

Publisher
¥ Appearance
BackgroundColor
¥ Layout

Position (Left,Top)
Left

Top
Size (Width,Height)
Width
Height
¥ Behavior (Input)
TrendObjName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
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Additional Information
When positioning on the page as an object, you must enter the "TrendObjName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation Animatians ~ B x
. Trend_Scrolldown0

aCtlon' imations < Sealect Animation to Add > -
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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12 Document Viewer Control IAG

12-1 Show Document

® External specification

Object name

Show_document

Category IAG_Document
Description Displays a specified document at a specified size (length and width).
Features Specifies the document display position and size using four Integer variables.

Graphic expression

Not pressed:

]

Pressed:
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 show_document0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. -—- - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
DocumentResourcel Specifies the document ID *3 Direct input Character string (Blank)
D (String)
*4
Top_Position Specifies the document display position (Y-axis) *2, *5 Direct input Numerical (Blank)
(Integer)
Left_Position Specifies the document display position (X-axis) *2, *5 Direct input Numerical (Blank)
(Integer)
Size_Width Specifies the document width *6 Direct input Numerical (Blank)
(Integer)
Size_Height Specifies the document height *6 Direct input Numerical (Blank)
(Integer)

Properties screen
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w General

Hame Show_documentt

*1.
*2.
*3.

*4.
*5.

*6.

"Transparent" indicates that the color is transparent.

The coordinate origin is the upper-left corner of the NA-series PT screen.

Enter the ID of the document registered in the resources.

Example: Document0

When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
Specify the coordinates of the top and left of the document viewer object.

Specify a Y-axis coordinate in Top_Position.

Specify an X-axis coordinate in Left_Position.

Specify the display size of the document viewer object. Only positive values are valid.
Specify the width of the object in Size_Width.

Specify the height of the object in Size_Height.

98
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Additional Information

When positioning on the page as an object, you must enter the
"DocumentResourcelD", "Top_Position", "Left Position", "Size_Width", and
"Size_Height" properties.

A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

act|0n . | < Select Animation to Add >
For details, refer to "Animations". Move

ResizeHeight
ResizeWidth
Visibility
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12-2 Show Document (Full Screen)

® External specification

Object name

show_document_full_screen

Category IAG_Document
Description Displays the specified document in full-screen mode.
Features The view is fixed at full-screen.

Graphic expression

Not pressed:

Pressed:
® Properties
Property Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 show_document_full_s
that screen. characters) creen0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. -—- - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (60, 60)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 60
Spin button Numerical
Height Specifies the object height. Direct input Numerical 60
Spin button Numerical
Behavior (Input)
DocResource Specifies the document ID *3 Direct Character string (Blank)
specification (String)
*4

Properties screen

¥ General

Name Show_document_full_screen0

Type 1AG

Version 1.0

Publisher Omron

¥ Appearance
BackgroundColor [ Transparent

Layout

Position (Left, Top) 280, 330
Left 280
Top 330

Size (Width,Height) 60, 60
Width &0
Height 60

Behavior (Input)

DocResource
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. Enter the ID of the document registered in the resources.

Example: Document0

*4. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

it
Additional Information

When positioning on the page as an object, you must enter the "DocResource"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation

aCtion . < Select Animation to Add >
For details, refer to "Animations". [l

ResizeHeight
ResizeWidth
Visibility
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13 Compound IAG Objects

13-1 Alarm Control Compound Object

® External specification

Object name

Alarm_composition_all

Category IAG_Alarm

Description [Clear Alarm Log] [Check Selected Alarm] [Check All Alarms]
Compound IAG consisting of three objects.

Features Easy customization such as adding, deleting, and moving buttons.

Graphic expression

)

Not pressed

%

L

)
aull

Press_[Clear Alarm Log]: Display/function of each button is same as a single button.

Press_[Check Selected Alarm]: Display/function of each button is same as a single button.

Press_[Check All Alarms]: Display/function of each button is same as a single button.

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Alarm_composition_all
that screen. characters) 0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. -—- - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical ---
position of the top-left of the object. Spin button Numerical
V¥ Size (Width, Specifies the size of the object. Direct input Numerical (213, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 213
Spin button Numerical
Height Specifies the object height. Direct input Numerical 66
Spin button Numerical
Behavior (Input)
AlarmObjectName Specifies the alarm viewer object name. Direct input Character string (Blank)
(String)
*3

Properties screen
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¥ General
Name Alarm_compasition_all

*1. "Transparent” indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

o
Additional Information
When positioning on the page as an object, you must enter the "AlarmObjectName"
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCt|0n / t ,= < Select Animation to Add >

For details, refer to "Animations".

Move

ResizeHeight

ResizeWidth
Visibility
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IAG Objects

13-2 Alarm Viewer Control Compound Object

® External specification

Object name

Scroll_composition_all

Category IAG_Alarm

Description Compound IAG consisting of six objects: [Return to Top], [Scroll Up by Specified Number
of Lines], [Scroll Up One Line], [Scroll Down One Line], [Scroll Down by Specified Number
of Lines], [Go to End]

Features Enables entry of fewer properties than with individual placement of objects. (Two

properties as opposed to eight properties)
Easy customization such as adding, deleting, and moving buttons.

Graphic expression

Not Pressed: Pressed: Pressed: Pressed: Pressed: Pressed:
pressed Scroll Up Scroll Scroll Up Scroll Returnto | Go to End
One Line Down by Down by Top
One Line | Specified | Specified
Number Number
of Lines of Lines

Display/function of each button is same as a single button.

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Scroll_composition_all0
that screen. characters)
Type Specifies the object type. This item cannot be changed. | --- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (66, 386)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 66
Spin button Numerical
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Height Specifies the object height. Direct input Numerical 273
Spin button Numerical

Behavior (Input)

AlarmObjectName Specifies the alarm viewer object name. Direct input Character string (Blank)
(String)
*3

ViewScrollAmount Specifies the number of alarm scroll lines Direct input Numerical (Blank)
(Integer)

Properties screen

v General
Name Scroll_composition_allo

Type
Version

Publisher

¥ Appearance

BackgroundColor

Layout
Position (Left, Top)
Left

Top
Size (Width,Height)
Width

Height
Behavior (Input)
AlarmObjName

ViewerScrollAmount

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

-
Additional Information
When positioning on the page as an object, you must enter the "AlarmObjectName"
and "ViewScrollAmount" properties.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation
aCtion. Animations < Select Animation to Add >

For details, refer to "Animations". s

ResizeHeight
ResizeWidth
Visibility
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13-3 Media Player Compound Object

® External specification

Object name

Media_player_composition_all

Category IAG_Movie
Description [Stop] [Play] [Pause]
Compound IAG consisting of three objects.
Features Easy customization such as adding, deleting, and moving buttons.

Graphic expression

Not pressed:

Press_[Play]: Display/function of each button is same as a single button.

Press_[Pause]: Display/function of each button is same as a single button.

Press_[Stop]: Display/function of each button is same as a single button.

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Media_player_composit
that screen. characters) ion_all0
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (212, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 212
Spin button Numerical
Height Specifies the object height. Direct input Numerical 66
Spin button Numerical
Behavior (Input)
MovieObjName Specifies the media player object name. Direct input Character string (Blank)
(String)
*3

Properties screen

¥ General

BackgroundColor

¥ Size (Width,Height)
Width
Height
¥ Behavior (Input)
MavieOb)Name

Media_player_composition_allo

Tramsparent
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*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

=8 Additional Information
When positioning on the page as an object, you must enter the "MovieObjName"

property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
i Media_player_compaosition_allo
action. | : < Select Animation to Add >
For details, refer to "Animations". RO
ResizeHeight

ResizeWidth
Visibility
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13-4 Recipe Control Compound Object

® External specification

Object name

RecipeComposition

Category IAG_Recipe

Description Compound IAG consisting of eight objects: [Add Record] [Save] [Save As] [Delete]
[Import] [Export] [Read from Controller] [Write to Controller]

Features Easy customization such as adding, deleting, and moving buttons.

Graphic expression

=
E.u__‘_

Not pressed:

Press_[Add Record]: Display/function of each button is same as a single button.

Press_[Save]: Display/function of each button is same as a single button.

Press_[Save As]: Display/function of each button is same as a single button.

Press_[Delete]: Display/function of each button is same as a single button.

Press_[Import]: Display/function of each button is same as a single button.

Press_[Export]: Display/function of each button is same as a single button.

Press_[Read from Controller]: Display/function of each button is same as a single button.

Press_[Write to Controller]: Display/function of each button is same as a single button.

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 RecipeComposition0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - --- Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (509, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 509
Spin button Numerical
Height Specifies the object height. Direct input Numerical 66
Spin button Numerical
Behavior (Input)
RecipeObjName Specifies the recipe viewer object name. Direct input Character string (Blank)
(String)
*3
PathAndFileName File path and file name Direct input Character string (Blank)
*4 (String)
*3
NewlnstanceName Specifies Add/New instance name Direct input Character string (Blank)
(String)
*3

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)

107



13.Compound IAG Obijects

Properties screen

¥ General

Name RecipeComposition0d

Type 1AG

Version 1.0

Publisher
¥ Appearance
BackgroundColor
¥ Layout
¥ Pasition (Left, Top)

[] Transparent -

Left

Top

¥ Size (Width,Height)

width

Height
¥ Behavior (Input)
RecipeObjName

PathAndFileName

NewInstanceName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.

*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks

*4. The import file path and file name are as follows:

File path_SD card: \SDCard\Folder name\
_USB memory: \USBDisk\Folder name\Fil
Example: SDCard\Recipe0.csv: Specifies

File name
e name
"Recipe.csv" file in root directory of SD card

=
Additional Information

When positioning on the page as an object, you must enter the "RecipeObjName",

"PathAndFileName", and "NewlnstanceName" properties.

A build error will occur if not entered.

® Event and action

There are no event and action functions.

® Animation

You can define the basic animation

action.

For details, refer to "Animations".

108
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Move

ResizeHeight

ResizeWidth
Visibility
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13-5 Data Logging Compound Object

® External specification

Object name Datalog_composition
Category IAG_Trend
Description [Start Data Logging] [Stop Data Logging] [Clear Logged Data] [Save Logged Data]

Compound IAG consisting of four objects.

Features Easy customization such as adding, deleting, and moving buttons.

Graphic expression 4 P P
aea
Not pressed:

Press_[Start Data Logging]: Display/function of each button is same as a single button.

Press_[Stop Data Logging]: Display/function of each button is same as a single button.

Press_[Clear Logged Data]: Display/function of each button is same as a single button.

Press_[Save Logged Data]: Display/function of each button is same as a single button.

® Properties
Property | Description | Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Datalog_composition0
that screen. characters)
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (277, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 277
Spin button Numerical
Height Specifies the object height. Direct input Numerical 66
Spin button Numerical
Behavior (Input)
SelectDataSetName Specifies the name of the data set for logging. Direct input Character string (Blank)
(String)
*3

Properties screen

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
109



13.Compound IAG Obijects

¥ General
Name Datalog_composition0

Type
Version

Publisher

¥ Appearance

BackgroundColor

¥ Layout
Position (Left, Top)
Left

Top

Size (Width,Height)
Width

Height
¥ Behavior (Input)
SelectDataSetName

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".

Additional Information
When positioning on the page as an object, you must enter the "SelectDataSetName "
property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation T
. atalog_composition0
action. _ ions < Select Animation to Add > -
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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13-6 Trend Graph Control (Horizontal Axis) Compound Obiject

® External specification

Object name

Trend_graph_composition_all

Category IAG_Trend

Description [Scroll to Start Position] [Scroll Left] [Scroll Right] [Scroll to End Position] [Show/hide
Cursor 1] [Show/hide Cursor 2] [Show/Hide Analog] [Show/Hide Digital]
Compound IAG consisting of eight objects.

Features Easy customization such as adding, deleting, and moving buttons.

Graphic expression

ed

Not pressed:

Press_[Scroll to Start Position]: Display/function of each button is same as a single button.

Press_[Scroll Left]: Display/function of each button is same as a single button.

Press_[Scroll Right]: Display/function of each button is same as a single button.

Press_[Scroll to End Position]: Display/function of each button is same as a single button.

Press_[Show/hide Cursor 1]: Display/function of each button is same as a single button.

Press_[Show/hide Cursor 2]: Display/function of each button is same as a single button.

Press_[Show/hide Analog]: Display/function of each button is same as a single button.

Press_[Show/hide Digital]: Display/function of each button is same as a single button.

® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_graph_compositi
that screen. characters) on_allo
Type Specifies the object type. This item cannot be changed. - - IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - --- Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V¥ Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -—-
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (393, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 393
Spin button Numerical
Height Specifies the object height. Direct input Numerical 66
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)*3
CursorNo Specified show/hide cursor number Direct input Numerical (Blank)
*4 (Integer)
CursorVisible Specifies cursor show/hide Direct input Numerical (Blank)
*5 (Boolean)
DisplayMode Specifies the trend graph display mode Direct input Numerical (Blank)
*6 (Integer)

Properties screen
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v General

Name Trend_graph_composition_all0o

Type

Version

Publisher

¥ Appearance

BackgroundColor

Layout
Position (Left, Top)
Left

Size (Width,Height)
Width

Height
Behavior (Input)
TrendObjName

CursorNo

CursorVisible

DisplayMode

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
*4, Select1,2,0r3
1: Show Cursor 1 only
2: Show Cursor 2 only
3: Show both Cursor 1 and Cursor 2
*5. Specify a Boolean variable.
When the Boolean variable is "True", the cursor is shown. When "False", the cursor is hidden.
"0" or "1" can be entered instead of "True" or "False".
"0" is the equivalent of "False", and "1" is the equivalent of "True".
*6. Specify an Integer variable. Enter one of the values below to select the display mode.
Select 0, 1, or 2
0: Analog only
1: Digital only
2: Both

=
Additional Information

When positioning on the page as an object, you must enter the "TrendObjName"

property.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

You can define the basic animation ; -
graph_composition_all0

action. Animations < Select Animation to Add >

For details, refer to "Animations". Move

ResizeHeight
ResizeWidth
Visibility
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13-7 Trend Graph Control (Vertical Axis) Compound Object

® External specification

Object name Trend_graph_composition_all2
Category IAG_Trend
Description [Scroll Up] [Scroll Down] [Zoom In] [Zoom Out]
Compound IAG consisting of four objects.
Features Enables entry of fewer properties than with individual placement of objects. (Two
properties as opposed to eight properties)
Easy customization such as adding, deleting, and moving buttons.
Graphic expression Not Pressed: Pressed: Pressed: Pressed:
pressed | Scroll Up Scroll Down Zoom In Zoom Out
Display/function of each button is same as a single button.
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 Trend_graph_compositi
that screen. characters) on_all20
Type Specifies the object type. This item cannot be changed. | -- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (273, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 66
Spin button Numerical
Height Specifies the object height. Direct input Numerical 273
Spin button Numerical
Behavior (Input)
TrendObjName Specifies the trend graph object name. Direct input Character string (Blank)
(String)
*3
ZoomTarget Specifies the zoom-in direction Direct input Numerical (Blank)
*4 (Integer)

Properties screen
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¥ General

Name Trend_graph_composition_all20

Type

Version

Publisher

¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)
Left

Top

¥ Size (Width,Height)

Width

Height
¥ Behavior (Input)
TrendObjName

ZoomTarget

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
*4. Specify an Integer variable. Enter one of the values below to select the zoom-in setting.
Select 0, 1, or 2
0: Both  Zoom-in both X- and Y-axes
1: X-axis Zoom-in X-axis
2: Y-axis Zoom-in Y-axis

Additional Information
When positioning on the page as an object, you must enter the "TrendObjName" and
"ZoomTarget" properties.
A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation
You can define the basic animation
. Trend_graph_composition_all20
action. Animatic < Select Animation to Add > v
For details, refer to "Animations". Move

ResizeHeight

ResizeWidth
Visibility
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13-8 Show Document Compound Obiject

® External specification

Object name

document_viewer_composition_all

Category IAG_Document
Description [Show Document] [Show Document (Full Screen)]
Compound IAG consisting of two objects.
Features Easy customization such as adding, deleting, and moving buttons.

Graphic expression

Not pressed

Press_[Show Document]: Display/function of each button is same as a single button.

Press_[Show Document (Full Screen)]: Display/function of each button is same as a single

button.
® Properties
Property | Description Input method Range Default
General
Name Specifies the object name. The name must be unique in | Direct input String (1 to 127 document_viewer_com
that screen. characters) position_all0
Type Specifies the object type. This item cannot be changed. | -- --- IAG
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Iltem selection Color palette Transparent
Direct input String *1
Layout
V Position (Left, Top) | Specifies the position of the object on the page.* 2 Direct input Numerical -
Spin button Numerical
Left Specifies the horizontal page coordinate (x-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of the Direct input Numerical -
position of the top-left of the object. Spin button Numerical
V Size (Width, Specifies the size of the object. Direct input Numerical (273, 66)
Height) Spin button Numerical
Width Specifies the object width. Direct input Numerical 273
Spin button Numerical
Height Specifies the object height. Direct input Numerical 66
Spin button Numerical
Behavior (Input)
DocumentResourcel Specifies the document ID *3 Direct input Character string (Blank)
D (String)
*4
Top_Position Specifies the document display position (Y-axis) *2, *5 Direct input Numerical (Blank)
(Integer)
Left_Position Specifies the document display position (X-axis) *2, *5 Direct input Numerical (Blank)
(Integer)
Size_Width Specifies the document width *6 Direct input Numerical (Blank)
(Integer)
Size_Height Specifies the document height *6 Direct input Numerical (Blank)
(Integer)

Properties screen
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Document_viewer_compasition_alll

*1. "Transparent" indicates that the color is transparent.
*2. The coordinate origin is the upper-left corner of the NA-series PT screen.
*3. Enter the ID of the document registered in the resources.
Example: Document0
*4. When directly entering a string in a Behavior (Input) property, enclose the string with quotation marks " ".
*5. Specify the coordinates of the top and left of the document viewer object.
Specify a Y-axis coordinate in Top_Position.
Specify an X-axis coordinate in Left_Position.
*6. Specify the display size of the document viewer object. Only positive values are valid.
Specify the width of the object in Size_Width.
Specify the height of the object in Size_Height.

=
Additional Information

When positioning on the page as an object, you must enter the
"DocumentResourcelD", "Top_Position", "Left_Position", "Size_Width", and
"Size_Height" properties.

A build error will occur if not entered.

® Event and action
There are no event and action functions.

® Animation

Document_viewer_composition_all0

You can define the basic animation

aCt|0n . < Select Animation to Add >
For details, refer to "Animations". MR
ResizeHeight

=

ResizeWidth
Visibility
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14 1AG Specifications

The IAG editor of the Sysmac Studio is used to create an IAG library. For this reason, the
functions that can be used vary depending on the NA version supported by the version of
the Sysmac Studio used to create the IAG library.
In general the functions are backwardly compatible, which means that an IAG library
created using an older NA version can be applied to a newer NA version.
This section explains the limitations that apply with an IAG editor as opposed to a regular
NA editor.

14-1 Property Input Limitations

The methods below can be used to enter properties in the Sysmac Studio (NA).
For details on the input methods, refer to Chapter 15, "How to Use IAG Objects".

Input method Description Appearance Support
Standard User-defined
objects properties
Direct input Entry of numbers and strings. Possible Possible
Spin button Entry of numbers. Possible Not possible.
Press A toincrementor V¥ to 14 -
decrement.
ltem selection Selection of items from a specific I/F.
The types below exist.
Font list For specification of a font. Possible Not possible.
Segoe UL q
|
Segoe UI Light
Segoe UI Semibold
Shruti
SimSun
SimSun-ExtB
Sylfaen
Symbol
Tahoma
Times Mew Roman
Trebuchet MS
Tunga
Verdana
Vrinda
Webdings
Wingdings
|
Style list For specification of a style. The four Possible Not possible.
styles below exist. Normal [=]
Normal
Bold
Bold Ttalic
Italic BoldItalic
Boldltalic
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Input method Description Appearance Support
Standard User-defined
objects properties
Iltem selection Selection of items from a specific I/F.
The types below exist.
Color palette For specification of a color s ci R .| |Possible Not possible.
Standard Colors
EEEEN EEEN
.|||||I|I||III
Custem Colors
Resource ID For specification of the ID of a string, | | Possible Not possible.
Mone > ...
animation, or other entity registered ]
in the resources.
Level selection  |For specification of a security level. — —1 |Possible Not possible.
All levels set in the security settings
are shown by drop-down display. Leve
Level 3
Level 4
Level 5
Checkboxes Check or uncheck to select. Use for Possible Not possible.
the settings of Boolean variables.
Variable Method for specifying NA global _ Possible Possible
specification variables. IntelliSense operates. *1
File specification |Specification of a file in a computer " El Possible Not possible.
one -
using Internet Explorer.
Plus button Use to add data to be referenced. S - Possible Not possible.
Add New i
Delete button Use to delete a property that was 5 Possible Not possible.
= (]
added with the plus button or by 5 [Daete
event selection.

*1. Cannot be used with the IntelliSense function (operates when a resource ID is entered) in the properties of a standard object.
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15 How to Use IAG Objects

15-1 Example

As an example, this chapter explains how to position the "Check Selected Alarm" button

included in the IAG library files provided by OMRON on the alarm viewer page of an
NA demonstration project file.

IAG library file : OmronStandardlAG_114A_E_AlarmButtons.iag
IAG object : "Check Selected Alarm" button ("Acknowledge _the selected alarm")
Project file : OmronStandardlAG_114A_E_AlarmButtons.smc2

15-2 Procedure

To use the IAG library, first import the distributed IAG file.

Once the file is imported, you can place the button using the same procedure as a standard
object.

Steps

Import the IAG library files into the Sysmac Studio

¥

Place on the IAG page

2

Set the IAG properties

%

Specify standard objects included in the IAG

|jl{s Additional Information

You cannot edit the IAG library using an IAG library file (file extension "iag").

To edit the library, obtain the project files (file extension "smc2") that are the source
for the 1AG library files, and import into the Sysmac Studio.

Ask your OMRON representative for information on how to obtain the files.

NA-series OMRON Standard IAG Library Application Guide (V415-E1-01)
119



15.How to Use IAG Objects

15-3 Importing IAG Library Files Into the Sysmac Studio
To import IAG library files, use IAG Collections Manager.

1. Copy the distributed IAG files to
any folder.
In this example, the files are copied
to the desktop.

2. Start the Sysmac Studio.

3. Open the project file that uses the

IAG.
4. Load the IAG file into the Sysmac Project ML Simulation.ToolsHelp.
Studio on this computer. Bl et e T

Click "Project" -> "IAG Collections
Manager" to open IAG Collections
Manager.

 IAG Collections Manager Ctrl+8

5. The IAG Collections Manager
pop-up window opens.
To add the IAG file, click the "+"
button in the lower left corner.

6 Select Organize « || Open Share with ~ New folder =~ 0l @
' ¢ Favorites : Mame =
"OmronStandardIAG_114A_E_Alar e e —
mButtons.iag" on the desktop and el L StndardiAG Al
. @ o L || StandardIAG_Dif L a E|
click the Open button. o L StndlsrdlAG MediaPlayerBustons izg =
7. "OmronStandardlAG_114A_E_Alar s Ao

mButtons.iag" is added to IAG
Collections Manager.

Make sure the correct file was
added, and make sure that a
checkmark appears in "Show in
Toolbox" at the upper right.  *1

8. Close the IAG Collections Manager
pop-up window.
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=
Additional Information

*1. When "Show in Toolbox" is selected, the IAG library appears in the Sysmac
Studio toolbox.

E Show in Toolbox

9. Make sure the following category is
added to the Sysmac Studio toolbox.

<Search»

P Shapes

¢IAG_Alarm

» Standard Controls

This completes the import el

procedure.

» HMI Controls

» Custom

P Amows

» Blowers

» Conveyors

» Flags

» Flow Meters
Hoppers

» Motors

» Pipes

» Pumps

» Tanks

» Valves

» Warning Signs

15-4 Placing on the IAG Page

The steps for placement on the IAG page are the same as for a standard object.

1. Click "»" next to the new "IAG

Alarm" in the tOOlbOX to open the én:/ Acknowladge_all_user_alarms
categories.

Acknowladge_latest_user_slarm
The IAG objects included in the 0| Acknowladge.the se
"IAG_Alarm" category appear. . p—

Make sure that
"Acknowledge the selected alarm

Clear_all_user_alarmlog

appears.
2- Drag ‘) ‘ ¥ 1MG_Alarm
p)
"Acknowledge the selected alarm" l v )| A
= = = i o\wladge:_all_user_alarms

to the desired position on the page.

)
1-;;/ Ackr @ ladge: latest user_alarm

| Alarm_compasition_all

il
=il |

Clear_all_user_alarmlog
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15-5 Setting the IAG Properties (User-Set Properties)

This section explains how to set the properties.
Use either "direct input" or "specify variable" as appropriate for the objective of the IAG.

e How to set the properties (specify variable)

1. Declare the string variable to be
allocated in the properties.
Double-click "Data" -> "Global
Variables" to open the global
variable table.

| Mi_1Package
Boslean(l0)

I:IEDDDE[I 1000000000000

Herame

| Recipeviewers |
[TrendGagh |
| UserAlarmvi |

jiDDU!D:EGDU;tI.I 10000000000

ooooo

2. Right-click on the global variable
table and select "Create New".

| Initial Value | AT | Retain | Constant | Update

Language O | N@I‘E
| Wordlamp_data O 0O |Nene
O O  [Nene

NJ_1.Conv-- H [0 [500 Millised

NJ_1.Conv-- O 1 |500 Millised]

NJ_1.Canv-- 0 [ [500 Millised]

NJ_LConv [ ] [ |500 Milliseq)

NJ_1Data- O 1 [500 Millised

NJ 1Pack— | [] [0 500 Millised

NJ_LProd O [ 500 Millised

3. Make sure that the global variable
has been added.

I Initial Value | AT | Retain | Constant | Update
alm Boolean|(5) O [0 [Nene
Language Boalean(5) O O None
Wil s dots Bata [ = ki

P I I L = "

| E5] I | [ O 1 O ke 1]
Bitlamp_Uata Boolean (] L1 MNone
NJ_1_ConveiorPosition Short{1) NJ_1.Conv-- | [ {500 Millised]
MJ_1 ConveiorStartSen -~ | Boolean NJ_1.Conv-- ['_"[ E[ 500 Millise]
MJ_1_ConveiorStartSW Boolean NJ_1.Conv l:| E[ 200 Milliseq
NJ_1_ConveiorStopSen--- | Boolean NJ_1.Conv- O []  [500 Millised]

4. Enter the name and data type.
First enter "AlarmViewer0" for the
name.

Next enter "String" for the data

type.

Alarm\Viewer(] String

O [0 [None

Bitlamp_Data Boolean O ] N&;)e
| N1 ConveiorPosition Short{1) NJ 1.Conv (| D 500 Millise:
NJ_1_ConveiorStartSen Boolean NJ_1.Conv 1 1 [500 Millise
NJ_1_ConveiorStartSW Boolean NJ_1.Canv-- o0 il 500 Millise

5. Enter the name of the alarm viewer
object to be specified as the default
setting.

Enter "AlarmViewerQ" here. *1

| Retain | Constant | Update Rate |

(] u] ;
Bitlamp_Data Boolean O 01 None
NI_L_ConveiorPosition | Short(l) NJ_LConv O 1 |500 Millisecands
NJ_L_ConveiorStartSen-— | Boolean NJ_1.Conv O [  |500 Milliseconds
NJ_1_ConveiorStartSW Boolean NJ_1.Conv-- O D 500 Milliseconds
NJ_1_ConveiorStopSen--- | Boolean NJ_1.Conv-- O O 500 Milliseconds
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6. When you have finished entering
the variable, return to the page on
which you placed the IAG object.

{. Select"View" -> "Properties" in the
menu in order to edit the IAG
properties.

NA_Demo(V101)_150205]_12ini Tel IMNJ]_5 - NAS_1 - Sysmac £
8 nA_Demo(v101)_ _E_E;MHG_ _1 - Sys

File Edil WView nsert Project HMI Simulation Tools Help

[ [ a Multiview Explorer Alt+1
1 Toalbox Alt+2
UG d: COutput Tab Page Alt+3
: Watch Tab Page Alt+4
NAS 1 Build Tab Page Alt+6
Search and Replace Results Tab Page  Alt+7
Page Explorer Ctrl+Shift+1
Code Explorer Curl+Shift+2  F2Th&
TR 2 I-AIF
Properties Ctri+Shift+3
ANIMATons LI+ 5NITT+4
Events and Actions Ctrl+5Shift+5
Smart Project Search Ctri+Shift+F
Recently Closed Windows Ctri+Shift+H I
Clear Recently Closed Windows History
Zoom 3
Reset Window Layout

8. The Properties window opens on
the right. Click the
"Acknowledge_the_selected
alarm" IAG that you placed
to show the properties.

9. Click "Behavior (Input)" in the
properties ->enter "AlarmViewerQ"
to be specified to "AlarmObjName".
Select [AlarmViewer0].

¥ Behavior (Input)
AlarmObjName
String AlarmViewerQ |

«» [AlarmViewerd
@ alm
And
= Andalso

@ array_end

@ Bitlamp_Data
|== Boolean
| @ Button_Bit

10. This completes the entry
procedure.

AlarmViewer0

*1. When using a string variable to specify the default setting, enclose the string in ' ' marks.
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e How to set the properties (direct input)

1. Open the page on which you
placed the IAG object.
2. Select "View" -> "Properties” in the B NA Demo(Vioi) 150305 Saneh Feirend Camii 5 - NAS 1 - Syamac ¢

menu in order to edit the IAG File Edit View Insert Project HMI Simuizton Tools Help
properties_ [ W Multiview Explorer Alt+1
L Toalbox Alt+2
= g= Output Tab Page Alb+3
= Watch Tab Page Ale+4
NAS_1 Build Tab Page Alt+6

Search and Replace Results Tab Page  Alt+7

Page Explorer Ctri+Shift+1
Code Explorer Ctrl+Shift+2
ANITTEaUOnS LLI+DIL+
Events and Actions Ctrl+5hift+5
Smart Project Search Ctri+Shift+F
Recently Closed Windows Ctrl+Shift+H
Clear Recently Closed Windows History

Zoom 3

Reset Window Layout

The Properties window opens on =] Propertes
the right. Click the ‘ :
"Acknowledge_the_selected_ ome ‘Acknowiadge. the_selected_slarmo
alarm" IAG that you placed
to show the properties.

680, 310
60, 60

AlarmObjName

Click "Behavior (Input)" in the K Bt Unpstt)
properties ->enter "AlarmViewer(Q"
to be specified to "AlarmObjName".
Enter ["AlarmViewer(0"] here
(include the quotation marks). *1

This completes the entry ¥ Behavior (Input)
procedure. -AlarmObjName "AlarmViewer0"

*1. When setting a string by direct entry, enclose the string in " " marks.
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